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We Will Not Be Creating Networks from Scratch 
Just Making them into Houdini Digital Assets

Goals

Learn to Create a Simple Digital Asset 

Identify Parts of your Network to promote to UI of 
Digital Asset 

Understand the Panels of the Type Properties Panel 

Create Guide Geometry 

Create Handles



Bottom Line - Learn the Type Properties Window



Not a Procedural Modeling Workshop

If you need to learn Procedural Modeling… 

http://www.sidefx.com/index.php?
option=com_content&task=blogcategory&id=222&Itemid=383 

!

http://www.sidefx.com/index.php?option=com_content&task=blogcategory&id=222&Itemid=383


Project 01 - Capsule Asset



Objectives

Create a new primitive type (e.g., Cube, Sphere, Torus) named capsule 

Digital Asset should allow the artist to control 

 Radius, Height, Bulge, Flatness 

 One or Two sided 

 Hollow 

 Orientation 

 UVs 

Digital Asset should have 

 Guide Geometry 

 Handles 

 HUD Control 

 Tool Bar Controls 

 Icon Embedded into Asset

Handle

HUD

Guide 
Geometry

Tool Box



Understanding the Basic Network



Understanding the Network

First we are going to create half of the profile of the Capsule 

The Circle Determines the radius of the Capsule 

The Line’s ty and distance are determined by the Circle



Understanding the Network (cont.)

The Carve SOP will determine the “Flatness” of the bulge in the capsule 

The First U is fixed to 0.25  

 This parameter should be locked so the network does not break 

 Lock it 

The Second U is what determines the flatness of the bulge 

 The range can be from 0.25-0.5



Understanding the Network (cont.)

Now we want the Artists to be able to choose between a full 
capsule and a half capsule (silo) 

We mirror the profile and join the two curves  

A switch determines if it will be a full capsule or silo



Understanding the Network (cont.)

To create clean uvs we are going to use the Basis SOP (see next slides) 

Then we can revolve the curve into the capsule 

Another Basis SOP is used to clean up the knotts in the Capsule’s surface



First Diversion - Basis SOP



First Diversion - Basis SOP



First Diversion - Basis SOP



Determining Which Parameters to Promote 

When creating a digital asset I like to color code all the nodes that have parameters that I 
want to promote. This way when creation the user interface it is easy for me to see where 
the parameters are that need a UI.  

 I usually use a pale yellow 

Refer to the Objectives slide for what parameters we need



Understanding the Network (cont.)

Two Switches to determine if the artist wants to apply uvs and 
if the artist want the Capsule to be hollow or not



Understanding the Network (cont.)

If the artist wants a hollow capsule he can then decide the thickness of the walls 

We use a Peak SOP (see following slide) to shrink the capsule. This will become 
the inner wall 

Carve SOP will leave only the end caps circle for both the inner and outer wall 

We then skin the two circles to create the faces between the inner and outer wall 

Finally we merge everything back together



Second Diversion - Peak SOP



Creating the Basic HDA



Reminder - Objectives

Create a new primitive type (e.g., Cube, Sphere, Torus) named capsule 

Digital Asset should allow the artist to control 

 Radius, Height, Bulge, Flatness 

 One or Two sided 

 Hollow 

 Orientation 

 UVs 

Digital Asset should have 

 Guide Geometry 

 Handles 

 HUD Control 

 Tool Bar Controls 

 Icon Embedded into Asset

Handle

HUD

Guide 
Geometry

Tool Bar



Color the Nodes that have Parameters that you want to 
Promote a light yellow. This will be you visual Todo List

Step One - Identify Parameters to Promote to Digital Asset 



Creating an HDA

Creating a SubNetwork 

Creating an HDA 

 Where should I save it? 

 Naming and Versioning



Creating the Digital Asset

1. Select all the Nodes you want as part of the Digital Asset 

2. Put the nodes in a subnet using either the toolbar icon or the 
keyboard shortcut Shift-C 

 Rename the subnet “capsule” 

3. Right Click on the Capsule subnet and select “Create Digital Asset 

4. A “Create New Digital Asset from Node” dialog box appears 

 (continued on next slide)

Subnet



Creating the Digital Asset (cont.)

Operator Name - When the Capsule SOP is dropped down in a 
network what label will it display 

Operator Label - Name seen when going through the Tab Menu 

Min/Max Inputs - How many input contexts can be wired to the node 

Save to Library - Where should the OTL be saved

OTL? -next 
slide



What is an OTL?

You save digital assets in operator type library files (OTLs) 

Depending on where you save the OTL file 

  You can make it available to every user,  

 To every project, to all files in one project, or just in one scene 

 An OTL can exist as a file on disk or be embedded in a scene file.

An OTL can store 
multiple HDAs.  

While you can save a 
HDA anywhere I like to 

save it on the Project 
Folder



Project Folder Structure

I usually create a project folder with the following folders 
inside it. Houdini will automatically search these folders 
when the Hip file is loaded. There is a “otls” folder. If you 
save your digital asset to this folder the HDA will 
automatically be installed when the file is loaded 

OTLs 
folder

$HIP/otls

capsule_v001.otl



The Colors of An Asset

Red - Editable Asset 

Blue - Locked Asset



Editable, Saved, Match Definition
Remember to Save 

Operator before Match 
Definition or your 

changes will be lost



A Color Gotcha… Comments

You can add a comment to any node. Here I am 
adding a comment to a Box SOP 

Once you add a comment the label of the node 
turns to dark blue 

Do not get confused between a comment (dark 
blue) and a locked asset (light blue) 

No Comment

Comment Digital Asset



Where Do Comments Show Up?

Middle Click on the Box SOP

Comment 
Appears Here



Here is where you will spend most of your time assetizing the HDA

Edit Operator Type Properties

You can always call up the 
“Edit Type Properties” 
window



Some Best Practices. More to come…

If the Digital Asset you are creating is similar to another Digital 
Asset or Node in Houdini use the same Parameter Labels 

Label your nodes descriptive names 

Break up the User Interface into Logical Areas 

Lock Parameters that you or other TDs do not need to change 

Make the Asset Flexible so it is not a One Off 

Test, Test, Test… Before giving it to others 



Examining the Tube Asset

Can choose Prim Type

Can choose Orientation

Can choose Center

Can Choose Radius and Height

Can Choose Caps and Number 
of Rows

“If the Digital Asset you are creating is similar 
to another Digital Asset or Node in Houdini 

use the same Parameter Labels” 



How Do I Load a Digital Asset?

If I create a new Scene file (.hip) I might have to manually 
install the Digital Asset. 

Choose File > Install Digital Asset Library.  

Select the digital asset file you want to install.  

Use the Install Library To option to choose where you want the 
type library to be available. 

As you progress in 
making your Digital 

Asset You can save new 
versions…



How Do I Save New Versions of an HDA? 

Open the Edit Operator Type Library 

In the top parameter “Save to Library” enter a new 
version or new name 

Click “Apply” or “Accept” for a new version to be saved 

Optionally you can also add a Version String in the Version 
parameter. This is only used for reference in scripts

Type in new version number or 
name here.

This parameter is optional. It can be 
used referenced when creating Python 
or HScript scripts



How Do I Save New Versions of an HDA? (cont.) 

Another way to save an Asset is to Embed the Asset into the Hip file 

This makes the project very portable at the expense of increasing the memory footprint of the saved file 

To embed an asset all you have to do is: 

Save to Library - Type “Embedded” in the parameter 

Type in Embedded



How Do I Choose Which Version on the Asset to Use?

The Operator Type Manager allows the user to switch which version of the Asset is active in the 
network 

Right Click on the Asset and Select “Operator Type Manager…”  

Find the Asset and Version you want to select and RIGHT CLICK  

Select “Use This Definition” 

Colors of definition names 

 Green - current definition is being used for that operator type.  

 Yellow - current definition for that operator type, but there is a more recent definition available 
in another operator type library 

 Red - not the current definition for the specified operator 

Operator Type Manager

Use This Definition



Creating Icons for Shelf Tools and Nodes



Creating an Icon and Storing it to Drive
Any jpg, png, svg, or pic can be used to create an icon for your Asset 

Any size will work, but it is recommended to use a square size. 48 pixels x 48 pixels 

To store an asset to your drive I recommend creating an “icons” folder in the folder that is holding your 
hip file. 

Store you image file in the icons folder 

To read the image into the asset there are two locations for the image to be read 

 Basic Tab - This is the icon to be used for the shelf tool 

 Tools—>Options Tab - This is the icon to be used for Tab menus and nodes 

In the Tools—Options Tab point to the icon. $HIP/icons/capsule.png 

!
  

Icons



Embedding the Icon into the Asset

By embedding the icon into the digital asset you make 
the asset more portable because there are no image 
dependencies 

To do this we will use the Extras Files Tab 

  

The Extra Files Tab 
allows you to embed 

all sorts of files 
including image files, 
pdfs, text, and code 



Using Extras Files

In the Extra Files Tab at the Bottom 

 Create a Section Name - icons 

 File Name - $HIP/icons/capsule.png 

 Click - Add File 

Now in the Tools Tab 

 Icon - Opdef:Sop/ari_capsule?capsule.png 

We can also now specify an icon for the Desktop 

 opdef:/Sop/ari_capsule?IconImage 
!
  



Opdef & Oplib



Creating a SubMenu for the Asset

Switch to the Tools Tab of the 
Operator Type Properties 
Window 

Got to the Context Submenu 

Tab Submenu Path - “Enter Your 
Name”



Basic Data Types
Color 

File 

File - Geometry 

File - Image 

Float 

Integer 

Folder 

Operator List 

Operator Path 

Ordered menu 

Ramp Color 

Ramp Float 

Separator 

Toggle



Promoting Parameters to the Digital Asset

Before we begin make sure : 

 Prefix Linked Parameter Label with Source Node Label - Deselected 

 Prefix Linked Parameter Name with Source Node Name - Deselected 

Dive into the Network (Make sure it is editable - red label) 

Let us start with the circle_cap SOP 

 Drag and Drop the rady parameter onto the root icon of the Edit Operator Type Properties Window 

 Change the Label to “Radius” 

 Select the Range Toggle and set the min range to 0.1.  

 Set Max range to 5 

 Lock the min range value 

Click Apply 

Test Radius 

Notice the type was automatically set to float 

Let us try another parameter 

 Drag and Drop the tz (center z) parameter onto the root icon of the Edit Operator Type Properties Window 

 Change the Label to “Height” 

 Select the Range Toggle and set the min range to 0.1.  

 Set Max range to 5 

 Lock the min range value 

Click Apply 

Test Height

Result So Far…



Toggles

Let us promote another type of value, an integer 

Select the “Select Input” of the switch_hollow1 SOP 

Drag and drop it on the obj icon 

 Change the name to hollow 

 Change the Label to Hollow 

Notice theType is set to Integer 

Switch to the Channels Tab 

 You can see the integer value defaults to 0 - not hollow 

 And the UI is linked to the switch node



Toggles (cont.)

Right now the Type is set to Integer 

Therefore you can set a range (min/max) 

It would be better to be able to set this to on/off 

 On - it is hollow, Off - it is solid 

That is where Toggles come in 

Change Type to Toggle 

Select Apply 

Toggle



Creating a Simple Menu

Adding Orientation



Mimicking the Tube SOP’s Orientation 

We want to create some logic that mimics the Tube 
SOP’s Orientation Parameter 

Label - Orientation 

Name - orientation 

Parameter Values - X Axis, Y Axis, Z Axis



Adding to the Network

Note - I like to add a Null for z_orientation so it is easier to 
read the logic. Completely optional



Making a Simple Drop Down Menu

Drag the Select Input parameter of the Switch SOP into the Type Properties 
Window 

Notice the type is an integer. We will keep it as an integer since this time we are not 
creating a “Toggle” 

Switch to the Menu Tab 

 Select “Use Menu” 

 Right under Menu Items there are two blank fields. Enter: 

 Token - 0, Label X-Axis. Hit the Enter Key 

 Repeat: 

 Token - 1, Label Y-Axis 

 Token - 2, Label Z-Axis 

Hit Apply and test The Drop Down Menu 

!



Setting a Default Value

If we look at the Tube Asset we will see the default orientation of the Tube is 
the Y-Axis. Let us do the same. 

Switch to the Channels Tab 

 Size is 1 - This means that the parameter has only one value like integer 
or gloat, as opposed to color which would have 4 

 Defaults - Since X-Axis is 0, Y-Axis is 1, Z-Axis is 2 

 Set Defaults to 1 

Click Apply. 

In the parameter you might have to right click and select “revert to defaults”



Another Way to Set Defaults

Click on the gear icon in the parameters tab and select: 

 “Copy Defaults from Node” 

Be careful! This will pick up all the values in your 
network and make them defaults



Creating an Ordered Menu

Adding Primitive Type



What is an Ordered Menu?

A String Based Menu. Meaning that the index into the list 
is not important. Only the Key-Value is interpreted. 

This is different then the simple menu we created for 
orientation. In the simple menu the tokens where just a 
numerical value.



Creating an Ordered Menu

Let us make an ordered menu of Data Types for the 
capsule.  

Select the “convert_primitive_type” Sop 

Take a look at the “Convert To” drop down menu 

There are many choices to choose from 

Only a few make sense 

 Polygon 

 Mesh 

 Bezier Surface 

 NURBS Surface 

We will want to delete the other options

  

Tip 

Hitting the “/“ key brings 
up a find panel. Type 

“convert” and the enter 
and the convert node will 

be selected 



Creating an Ordered Menu (cont.)

Drag the “Convert To” parameter into the Type Libraries 

Notice the Type generated is: Ordered Menu 

Switch to the Menu Tab 

 Notice all the data types were imported 

 Notice the tokens are strings (e.g., poly”) 

We only want a few data types 

Delete everything except: poly, mesh, bezSurf, nurbSurf 

To delete click the “x” icon on the very right of the token/label 
pair Delete icon



Creating an Ordered Menu (cont.)

End result should look like the image on the right 

To set a default got to the Channels tab and enter a token 

 I entered “nubsSurf” for NURBS Surface 

Hit Apply and test results 



Disabling Parameters



Disabling Parameters

You know if you do not want a hollow capsule there is 
know reason to give the user control over the thickness of 
the capsule 

Open up the Type Properties Window 

Dive into the Network 

Select the Peak SOP 

Drag the “Distance” Parameter into the Parameters tab of 
the Type Properties window right below the “Hollow” 
parameter



Disabling Parameters (cont.)

In the “Hollow” parameter select “Horizontally Join to 
Next Parameter” 

Click “Apply” 

Notice the toggle and thickness are now on the same line 



Disabling Parameters (cont.)

We only want the artist to be able to Change Thickness if 
Hollow is Selected 

Otherwise Thickness should be grayed out 

Select the Thickness parameter in the Type Properties 

In the “Disable When” field type: 

 {hollow == 0 } 

Click Apply 

Notice if Hollow is not selected, Thickness is grayed out 



Disabling Parameters (cont.)

Hollow not selected - 
Thickness Grayed Out Hollow selected - Thickness 

Active



Adding to the Capsule Network

Creating Guide Geometry



What is Guide Geometry & How Do I Build it?

Guide Geometry helps the Artist visualize the digital 
asset in the viewport. It can be used together with 
handles to create a better User Experience 

While you can see Guide Geometry in the Viewport it 
never Renders

Guide Geometry in Blue



Adding to the Network for Guide Geometry

Two Branches 

Branch one - Take the circle of the bulge and unroll it to  
display a wireframe 

Branch two - Create a arc that will be used as a pointer 
to the handle we will be creating 

Merge the Two branches  

Create a NULL we will point to as our Guide Geometry



Pointing to the Guide Geometry

Open the Type Properties Window 

Select the Basic Tab 

In the Basic Tab click the SOP Selection Icon 

 Choose “Guide_Geometry_Out” 

Select “Apply”



Guide Geometry End  Result



Learning How to Create Handles

Artist Controls for Radius & Height



Handles

Houdini displays controls on objects and components in the viewer called handles, 
which you can manipulate to set parameters. 

Handles are equivalent to manipulators in other packages. 



Creating a Handle to Control Radius & Height

We know that Radius is controlled by the rady of the first circle 

We know that height is controlled by the tz of the first circle 

To create handles for the Radius and Height we will use the viewport 

(cont. on next slide)

  

Remember 

The green colored 
parameters indicate that 
they are being controlled 

by parameters at the 
digital asset level 

Controls Radius

Controls Height



Creating a Handle to Control Radius & Height (cont.)

Make sure the Type Properties window is open (very important) 

Dive into the Network and select “circle_cap” SOP 

Now Move over to the Scene Viewport and RIGHT Click on the 
Transform Handle of the Circle SOP 

In the Drop Down menu select Export Handle to Digital Asset 

Now let us look at the Type Properties Window 

Continued on Next Slide… 



Creating a Handle to Control Radius & Height (cont.)

In the Parameters Tab we can see that all the 
parameters  associated with the Circle SOP have 
been promoted to the Digital Asset 

Select the Handles Tab (next slide..)



Creating a Handle to Control Radius & Height (cont.)

In the Handles Tab we see a handle has been created 

The Name is Circle_Transformer and more importantly 
it is owned by “circle Cap 

We know this because Default - ownerop(‘circle_cap) 

Below this is a list of default bindings. For instance  
“sx" is bound to “radx" 



Creating a Handle to Control Radius & Height (cont.)

Delete all the bindings except for “sy” and “tz” 

Select apply and test handle 

“sy” will control the radius of the capsule 

“tz” will control the height



Seeing How Handles Can Work with Guide Geometry

Creating a Handle for Flatness



Creating a Handle For Flatness

We want to control the flatnes of the capsule’s bulge 

We know that the “Second U” of carve_cap_end 
controls the flatness 

We also know the values must be 

 min - 0.25 

 max - 0.5 

Make sure the Type Properties Window is Open 

Dive into the network and select carve_cap_end



Creating a Handle For Flatness (cont)

With “carve_cap_end” selected  hover over the scene 
viewport and right click on the handle for Second U  

Lets View the Type Properties Window 

Second U Handle



Creating a Handle For Flatness (cont)

Notice a new handle has been created for you - Second_U_To_Carve 

Go up to the Asset level and test the handle 

Notice the dagger moves with the handle 



Using a HUD in the Viewport

Controlling the Number of Divisions in the Revolve



HUD Displays

For a HUD (Heads Up Display) to work in the asset you must 
create it at the network level 

Dive into the network and select the “revolve” SOP 

In the Details Tab of the Revolve SOP drag the Divisions 
parameter onto the Scene Viewport 

Next slide… 



HUD Displays (cont.)

Notice a HUD is now displayed in the Viewport 

Activate it by hitting the Enter/Return key in the viewport 

The HUD will now appear with a red slider 
Not Active

Active



HUD Displays (cont.)

Go back up to the Asset level and Test 

Activate it by hitting the Enter/Return key in the viewport 

The HUD will now appear with a red slider 
Not Active

Active

  

Notice that HUD values 
are floating points but the 

Division Parameter is 
Integer. Houdini is flooring 
the values in the parameter 



and Tool Tips too

Creating a Help Card



Creating a Help Page

You can add a help card to your digital asset. Help can 
be written in three ways: 

 1. Plain Text - Place it “””  “”” in tripple quotes 

 2. Wiki Mark Up  

 3. HTML 

You can also just point to a url that contains the help 



Wiki Markup Help

In help if you search for “Writing help in wiki format” you will get full 
instructions in creating your Help Card



Creating  Parameter Tool-Tip Hints

For every parameter you can add a tool tip 

A tool tip is a descriptive comment to aid 
the artist in understanding the parameter 

Click Apply and Test
To create a Tool Tip enter 
text in the Help parameter

Tool Tip Appears Here



Using Folders  to Clean Up the Interface

Right now the Interface looks messy 

You can use folders to organize the parameters 

Folders really look like tabs in the User Interface 

Open up the Type Properties Widow and go to the 
Parameters Tab 

Drag a Two Folders to the Parameter Side 

Label the First -  “Capsule” 

Label the Second - “Detail” 

Place parameters under the folders 

Click Apply and Test



Promoting Common Parameters to the Tool Box

Let us examine the Tube SOP one more time 

Drop down a Tube SOP and Examine the Viewport 

Notice above the Viewport there is a “Tool Box” 
that contains the Tube SOPs most common 
parameters 

We can create out own Tool Box for the Capsule

Tool Box showing most 
commonly used parameters



Promoting Common Parameters to the Tool Box (cont.)

Open up the Type Properties Window and select the Radius Parameter 

Underneath the Range Options there is a Field labeled “Show Parm In” 

Change it from “Main Dialog Only” to “Main & Tool Dialogs + Toolbox” 

Hit Apply. Repeat this for each parameter you want in the Tool Box 

Test Results



Promoting Common Parameters to the Tool Box (cont.)



Project 02 - Needle Asset



Using the Input/Output Tab to  Create Tool Tips for Input 
Contexts

Open up the Needle.hip project 

When an artist wants to know how to wire up a node with 
multiple input contexts he/she will middle click on the 
context to get a tool tip of what to wire in 

Currently our digital asset does not have that information 



Using the Input/Output Tab to  Create Tool Tips for Input Contexts

Open the Type Properties Window 

Select the Input/Output Tab 

Currently there are no descriptions 

Enter in Input 1 Label - Profile Curve 

Enter in Input 21 Label - Backbone Curve 

Hit Apply and Test 

!

  

Notice when I modeled the 
Asset I used the Same 
Context Input Order as 

the Curve 



End of Creating Digital Assets - M01


